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1. Introduction 

Connectivity problems are a common source of modelling errors in finite element analysis 
(FEA). These issues can lead to unintended structural behaviour, and often result in warnings 
or errors during the solution process, particularly related to the condition of the stiffness 
matrix. 

In FEA, elements are typically connected by sharing nodes at their boundaries or corners. For 
compatible elements, each matching nodal degree of freedom at a shared node is rigidly 
linked. While other connection techniques – such as slidelines or constraint equations – are 
useful in specific scenarios, this technical note focuses on verifying basic connectivity based 
on shared nodes between adjacent elements. 

LUSAS is a feature-based Modeller, which means that the geometry of a structure is defined 
first. LUSAS then generates a mesh of elements and nodes within the geometric envelope. 
To ensure proper connectivity of the resulting mesh, the following geometric principles must 
be followed: 

• Volumes must share a common surface to be fully connected. 

• Surfaces must share a common line to be fully connected. 

• Lines must share a common point to be fully connected. 
 
Connectivity can therefore be verified at both the geometry level and the mesh level. 

2. Assessing connectivity 

2.1 Checking connectivity 

This section outlines various tools and methods available for checking connectivity. For 
additional information, refer to the following section in the Help documentation: 

Help menu > Help Topics > Contents > Modeller Reference Manual > Chapter 7 – 
Analyses > Pre-Analysis Checks 

2.1.1 Checking higher order features with datatips 

Higher-order features of a selected item can be quickly viewed by hovering the cursor over it 
in the graphics window, which will display a datatip. Examples: 

1) For a node, the datatip shows the coordinates and a list of elements connected to 
that node. 

2) For a point, it displays the coordinates, any assignments, and the higher-order lines 
associated with it. 

3) To verify that two adjacent surfaces are connected along a shared line, select the line 
and check the datatip. It should list both surfaces as being defined by that line. 

2.1.2 Selected items and cyclable items 

To view the items currently selected in the model, you can open the Selected Items window. 
This should be visible by default, but if not, it can be accessed by navigating to: 

View menu > Selection Panels > Selection 

A window will appear on the screen which will list all currently selected items (Figure 1).   

 



© Finite Element Analysis Ltd 2025 CSN/LUSAS/1036 

 

  Page 3 

 

Figure 1 – Selected items 

This tool can be useful for several tasks, including: 

• Checking mesh connectivity – For example, you can box-select an area that should 
contain a single node or point to verify that no duplicates exist. 

• Verifying imported geometry – Box-select areas where only one line or surface 
should exist to ensure no duplicates are present. 

• Identifying element types – Select an element and view its type in the selection list. 

• Refining selections – Roughly select an area, then deselect unwanted feature types 
or specific items to fine-tune your selection. 

 
This window can be docked within the Modeller window frame if you want it to remain 
permanently visible. 

Figure 2 demonstrates how the Selected Items window can be used to assess connectivity at 
the intersection of four lines. In Figure 2 a), a single point is present at the intersection, 
indicating that all four lines are properly connected through one node. In Figure 2 b), however, 
there are four coincident, unmerged points at the same location. This means the lines are not 
connected, and when the model is meshed, it will result in multiple coincident nodes, which 
can cause issues in the analysis. 

  

a) b) 

Figure 2 – a) A single point at the intersection of four lines and b) Four coincident, unmerged 
points at the intersection of four lines. 

Similarly, a Cyclable Items window is also available. It can be accessed via the View menu 
(View menu > Selection Panels > Cyclable Items). This window displays a list of items that 
are in close proximity to those already selected and could potentially be added to the 
selection. 

Like other panels, the Cyclable Items window can be docked within the Modeller window 
frame. To quickly dock or undock it, simply double-click on the window’s border. 
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2.1.3 Viewing mesh as outline plot 

Turning off the Geometry and other layers, and enabling the Outline only option in the Mesh 
layer properties, can help visually identify disconnected surface or volume mesh. To access 
the Mesh layer properties, either right-click on the Mesh layer in the Layers tab of the Tree 
View and select Properties from the context menu, or simply double-click the Mesh layer to 
open its properties directly (Figure 3). 
 

 

Figure 3 – Mesh layer properties – Outline only option. 

The mesh outline plot displays lines at mesh boundaries, splits, creases, joins, and other 
significant changes in angle, as well as the positions of bar or beam elements. In the example 
below (Figure 4), the geometry is first shown shaded in solid. This is followed by two mesh 
outline plots: one illustrating proper connectivity, and another highlighting issues where 
coincident, unmerged lines result in a split in the mesh. 

   

a) b) c) 

Figure 4 – Mesh outline plot example 

2.1.4 Check the deformed mesh 

A simple analysis, such as a linear static analysis under self-weight, can be performed as an 
initial check of the model. After running the analysis, the deformed mesh can be viewed with a 
specified deformation scale factor to visually assess the model's behaviour. 

To view the deformed mesh: 

View menu > Drawing Layer > Deformed Mesh 
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If any parts of the model are completely disconnected or lack support, they will appear 
noticeably displaced due to free body motion, clearly indicating issues with connectivity or 
boundary conditions.  

Figure 5 displays the deformed shape of an I-girder, clearly indicating that one of the 
stiffeners is not adequately connected to the girder. This insufficient connection results in 
excessive displacements and an unrealistic deformation, highlighting the need to revise the 
model and correct the connectivity issue. 

 

Figure 5 – Deformed mesh check – Disconnected stiffener. 

For partially connected components, viewing the deformed mesh at a specified deformation 
scale can reveal mesh discontinuities or unexpected deformations caused by connectivity 
issues. Figure 6 illustrates a case where a stiffener is connected only to the flanges of the I-
girder but remains disconnected from its web.  

 

Figure 6 – Deformed mesh check – Stiffener not connected to the web. 

2.1.5 Geometry layer – Colour by connectivity 

In the Properties dialog of the Geometry layer, there is a setting called "Colour by 
Line/Surface Connectivity" that visually highlights connectivity issues through colour coding. 
This feature provides the following options: 
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• Line Connectivity – Colours the points based on the number of lines connected to 
each point, and colours the lines according to the number of surfaces connected to 
each line. 

• Surface Connectivity – Colours the surfaces according to the number of volumes 
connected to each surface. 

For further information, please consult the following references:    

Help menu > Help Topics > Contents > Modeller Reference Manual>Chapter 2 - Using 
Modeller > Using Layers  

Help menu > Help Topics > Contents > Modeller Reference Manual>Chapter 4 - Model 
Geometry > Visualising Geometry 

Figure 7 shows an example of a continuous floor slab with beams. The surface geometry has 
been split to create internal points where column supports below will be modelled. The 
geometry is displayed with the Colour by "Line Connectivity" setting enabled, illustrating two 
cases: one with good connectivity (b) and one with connectivity issues (c). 

In the good connectivity example (b), all perimeter lines are coloured green, indicating – 
according to the key – that each line defines only one surface, which is correct. The internal 
lines are coloured blue because they are shared by two adjacent surfaces, reflecting proper 
connectivity. In contrast, example (c) shows some lines intended to be internal and shared 
between adjacent surfaces coloured green instead of blue. This means these lines define only 
a single surface, like the perimeter lines. In other words, the adjacent surfaces have 
coincident but unmerged lines, indicating a connectivity problem. 

a) 

 
b) 

 
c) 

 

Figure 7 – Colour by line connectivity – Floor slab with beams. 
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2.1.6 Mesh layer – Colour by connectivity 

Similarly, the mesh can be colour-coded to assess connectivity. This can be done by 
adjusting the Colour by setting in the Properties dialog of the Mesh layer to Edge 
Connectivity. This setting displays how many elements are connected to each node (by 
colouring the nodes accordingly) and how many elements are connected along each element 
edge (by applying a corresponding colour code to the edges). 

2.1.7 Using the Labels layer 

The Labels layer is helpful for identifying overlapping geometry – for example, when two 
points occupy the exact same location instead of just one. 

In the example shown in Figure 8, the same problematic geometry from Figure 7 is displayed 
with labelled lines. It becomes evident that lines 63 and 64, which are longer, overlap with 
lines 39 and 40, respectively. This overlap is clearly indicated by the positioning of the labels, 
which are placed at a specific parametric distance along each line. 

 

Figure 8 – Using the Labels layer – Coincident/overlapping lines revealed. 

2.1.8 Checking the distance between points 

To identify coincident points within a small region of the model, select a group of points and 
then go to: 

Geometry menu > Point > Distance Between Points 

This function calculates the distances between all pairs of selected points, making it easier to 
find the two closest points when working with a small selection. For more than six points 
(resulting in 15 or more pairs), you can copy the output from the text output window into Excel 
to analyse and identify the closest points more efficiently. 

2.1.9 Feature properties – Checking a geometry feature’s hierarchy 

The properties of a geometry feature – such as a point, line, or surface – can be accessed by 
selecting the feature of interest, then right-clicking and choosing Hierarchy from the context 
menu. 

Within the Hierarchy tab, you can view both the feature's lower-order defining features and 
higher-order dependent features. This helps confirm that the relationships are as intended. 
Figure 9 shows the Hierarchy tab for a line. This tab lists the lower-order features (points) that 
define the line, along with the higher-order features (surfaces) that are dependent on it. 
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Figure 9 – Geometry feature hierarchy 

2.1.10 Using Advanced Selection 

Advanced Selection allows the current selection to be filtered by specific criteria such as 
feature number, element name, stress model, or geometric/material attributes. It can be 
accessed via Edit menu > Advanced Selection, or by right-clicking in a blank area of the 
graphics window and selecting it from the context menu. 

This tool is particularly useful for tasks like checking the connectivity of coincident points. For 
example, after selecting one point, you can use Advanced Selection with the options Current 
selection, Add to selection, and Also apply to higher order to identify which higher-order 
features (e.g., lines or surfaces) are connected to each point. 

2.1.11 Using Visibility 

Features can be made visible by: 

• Selecting All Visible from the graphics window context menu (right-click in blank 
space > All Visible). 

• Making a group visible via the Groups tab in the Treeview (right-click on a group > 
Visible or Set as Only Visible). 

• Displaying features assigned with a specific attribute from the attribute’s context 
menu in the Attributes tab of the Treeview (right-click on an attribute > Visible or Set 
as Only Visible). 

• Using the Advanced Visibility dialog, accessible from the graphics window context 
menu (right-click in blank space > Advanced Visibility). 

The Advanced Visibility dialog provides fine control over which features are visible by 
managing the visibility of both higher-order and lower-order features. For example, it allows all 
lines connected to a point to be shown or all surfaces linked to a line to be hidden.  

Let’s now examine the connectivity issue shown in Figure 8. Line 64 can be isolated by 
setting it as the only visible feature on screen. Once isolated, it can be selected along with its 
end points (points 73 and 29). By using the Advanced Visibility tool, both higher-order and 
lower-order features can be displayed, as illustrated in Figure 10. 
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Only surface 20 is explicitly defined by line 64. However, surface 16 is also shown, along with 
its defining line 50, which partially overlaps line 64. This overlap occurs because lines 50 and 
64 share point 73. In a correctly connected model, line 50 should be shared by both surfaces 
16 and 20. 

a) 

 
b) 

 

Figure 10 – Using Advanced Visibility to check connectivity. 

2.2 Correcting connectivity problems 

This section outlines approaches for resolving the connectivity issues identified using the 
methods described earlier in this technical note. 

2.2.1 Merging coincident features 

By default, coincident features will merge automatically. Alternatively, you can merge them 
manually by selecting the features and navigating to: 

Geometry menu > Point/Line/Surface > Make Mergeable, followed by Merge. 
 
You can control how features merge by adjusting the Merge settings in: 
 
File menu > Model Properties > Geometry. 
 
The available Merge Action options are: 

• Off – Where no merging is carried out. 

• Exact (default) – Where features are merged only if all assignments are identical. 
This is the default. 

• Wild – Where features are merged if feature assignments of the same type for both 
features match. The assignments of both features are retained where the assignment 
type is unique to one feature. 

• Ignore assignment – Ignores the assignments when deciding if two objects should 
merge (this is the opposite of "Exact" where the two objects must have the same 
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assignments to merge). The assignments of the feature merged out will be 
transferred to the feature retained unless the retained feature already has that 
particular assignment.   

For more information, refer to: 

Help menu > Help Topics > Contents > Modeller Reference Manual > Chapter 4 - Model 
Geometry > Merging and Unmerging Features 

To ensure that geometry retains the correct assignments after merging, it is advisable to: 

• Allow merging with the Merge Action set to "Exact". 

• Assign attributes to all intended geometry after merging. 

• Alternatively, construct and merge geometry before assigning attributes. This 
approach helps maintain clarity during model construction and avoids unintentional 
merging issues caused by differing assignments. 

2.2.2 CAD export settings 

Model geometry and other associated data can be imported into Modeller via the File > Import 
menu. Supported file formats include: 

• CAD files: *.igs, *.dxf, *.step, *.stp, *.stl 

• BIM/BrIM files: *.ifc 

• FEA proprietary formats: *.e2k, *.mct, *.mgt, *.s2k 

For a complete list of supported file types and an explanation of the advanced import options, 
refer to the LUSAS documentation: 

Help menu > Help Topics > Contents > Modeller Reference Manual > Chapter 3 - File 
Types/Importing/Exporting > Importing/Exporting Data > Interface Files 

When importing geometry from an IGES file, it is possible that some lines defining the edges 
of surfaces may not be merged. This can result in adjacent surfaces not sharing a common 
edge, even though they appear to touch. This issue typically arises because the lines are not 
identical – often due to the modelling tolerance used when the geometry was created and 
exported from the CAD package.  

IGES files define surfaces individually, each with their own boundary lines. If these lines are 
not within the merge tolerance defined in Modeller, they will remain unmerged upon import. In 
many cases, it is not possible to merge them afterward, because the surface mapping 
generated in the CAD system is locked and cannot be modified within Modeller (see further 
discussion below). 

It’s important to note that the level of precision required for finite element analysis (FEA) is 
significantly greater than that required for typical CAD modelling. CAD systems generally 
apply a coarser default modelling tolerance, which may not be suitable for FEA purposes. To 
ensure successful import and accurate geometry merging, you should set the modelling 
tolerance in the CAD package before creating and exporting the geometry. This tolerance 
should be as tight as reasonably possible – ideally matching or closely approximating the 
default Modeller merge tolerance of 1.0E-6, which can be accessed via: 

File menu > Model Properties... > Geometry tab 

If a CAD model is created using a modelling tolerance of, for example, 0.01, then lines that 
are intended to be coincident – such as those defining the shared edge of two surfaces – may 
actually be offset by a distance such as 0.001. When this geometry is imported into LUSAS, 
which uses a default merge tolerance of 1.0E-6, such lines will not be merged because they 
fall outside the permitted threshold. This issue is especially pronounced with polylines, where 
curves are approximated based on the tolerance used during their creation. To avoid such 
discrepancies, it is recommended to set a tighter modelling tolerance—ideally 1.0E-6—in the 
CAD software prior to creating the geometry. Doing so ensures the exported geometry meets 
the precision requirements needed for successful merging in Modeller. 
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CAD software can also define surface mapping using NURBS surfaces. While LUSAS is 
capable of importing these surfaces and their associated mapping, it cannot modify them. 
This limitation exists because Modeller does not include the full range of surface editing tools 
available in CAD packages. Therefore, any adjustments to NURBS geometry or surface 
mapping must be made within the original CAD environment. 

Depending on the complexity of the required model, the geometry creation tools provided 
within LUSAS may be entirely sufficient, potentially eliminating the need to use a CAD 
package for geometry creation and import. 

Cylindrical or spherical surfaces created in a CAD package by sweeping a circle can result in 
a closed surface with a single ‘seam’. When such geometry is imported into LUSAS, the 
surface mapping may not be interpreted correctly, as the location of the seam can cause 
ambiguity in determining which side the mapping should reference. This can lead to incorrect 
surface representations. 

To avoid these issues, the following approaches are recommended: 

• Enable "Split Closed Surfaces" on IGES Export: Many CAD packages (e.g., Rhino) 
provide an option to split closed surfaces during IGES file export. Enabling this option 
divides the surface into two parts, introducing an additional seam that helps resolve 
mapping ambiguities during import. This is particularly useful not only for basic 
shapes like cylinders and spheres, but also for more complex closed surfaces that 
are difficult to split manually in the CAD environment. 

• Manually Split Surfaces in CAD Prior to Export: 
o For cylinders, instead of sweeping a full circle, create the surface by 

sweeping two semi-circles, which introduces two seams. For example, a 
cylindrical volume could be defined by extruding two semi-circular profiles to 
form two separate half-cylinder volumes, which can then be imported with 
improved surface mapping reliability. 

o For spheres, perform four 90-degree sweeps of a semi-circle to generate four 
seams. 

2.2.3 Ensuring elements sharing nodes have compatible nodal freedoms 

For guidance on ensuring that elements sharing nodes have compatible nodal freedoms, refer 
to the following resource: 

http://www.lusas.com/protected/theory/connecting_elements.html 

Additionally, a detailed summary of the nodal freedoms and other properties for each element 
available in LUSAS can be found in the software documentation under: 

Help menu > Help Topics > Contents > Element Reference Manual > Element Summary 
Tables 

2.2.4 Splitting geometry 

In certain cases, splitting geometry can help resolve connectivity issues caused by 
overlapping features. A common example is when two lines overlap: the issue can often be 
resolved by splitting one of the lines at the point of overlap. To do this, select the line and a 
point located along its length, then use the following menu option to divide the line into two 
segments at that point: 

Geometry menu > Line > By Splitting > At a Point… 

As shown in Figure 11a, lines 64 and 50 overlap. To resolve this, line 64 can be split at point 
59, creating a new line between points 59 and 73. This new line will be exactly coincident with 
line 50, allowing the two to be merged. Once merged, line 50 serves as the shared edge 
between surfaces 16 and 20. The updated geometry is illustrated in Figure 11b. In this 
configuration, line 64 is deleted, and a shorter line – line 65 – is created between points 29 
and 59. In many cases, additional adjustments may be necessary to ensure that newly 
created features are fully integrated with the existing geometry. 

http://www.lusas.com/protected/theory/connecting_elements.html
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a) 

 
b) 

 

Figure 11 – Using the By Splitting option to resolve connectivity issues caused by overlapping 
lines. 

Similarly, a surface can be split using a line. To do this, select both the surface and a line that 
fully spans across it, then use the following menu option to divide the surface into two along 
that line: 

Geometry menu > Surface > By Splitting > By Line… 

For additional tools and techniques related to splitting lines, surfaces, or volumes, refer to the 
documentation: 

Help menu > Help Topics > Contents > Modeller Reference Manual > Chapter 4 – Model 
Geometry > Points/Lines/Surfaces/Volumes 

2.2.5 Redefining geometry 

Depending on the complexity of the model and the extent of the connectivity issues identified, 
the analyst may determine that redefining the geometry in Modeller is a more practical and 
time-efficient solution than attempting to fix the issues directly. When redefining geometry or 
creating it from scratch, the following recommendations should be considered: 

• Complete all geometry import, manipulation, and editing before making any 
assignments (including mesh), where possible. This is because features are only 
merged by default if they share identical assignments. While it may be useful to test 
meshing during this stage, it is recommended to deassign the mesh before 
performing further geometry operations – such as splitting surfaces – to help ensure 
proper connectivity. 

• Where possible, define all surfaces using only 3 or 4 lines. Such surfaces are 
known as regular surfaces and are well-suited for grid-like shell meshing. They are 
easier to manipulate, modify, and refine, making them ideal for achieving a high-
quality mesh. In contrast, non-planar surfaces defined by 5 or more lines – often 
encountered in CAD imports as complex NURBS surfaces – cannot be easily edited 
by moving their defining lines or points, as the internal surface shape becomes 
indeterminate. 
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• Carefully plan the geometry based on the features to be modelled, the 
necessary assignments, the desired results, and areas where mesh control or 
refinement may be required. Investing time upfront to create the correct geometry is 
far more efficient than making extensive edits later in the modelling process. Surfaces 
should be drawn so that key lines and points are positioned where needed – for 
example, at member intersections, load and support locations, result extraction 
points, mesh refinement zones, or where constraint equations or contact definitions 
will be applied. Creating geometry with these considerations in mind reduces the 
need for retrospective splitting and helps prevent common modelling issues such as 
connectivity errors or incorrect assignments. Keep in mind that for surfaces to be fully 
connected, they must share common lines; for lines to be fully connected, they must 
share common points. Fully connected geometry ensures that the resulting mesh is 
continuous, with adjacent elements sharing common nodes. 

• Use the Move, Copy, and Sweep commands to build geometry progressively. 
Connectivity is more reliably achieved when geometry is created through controlled 
operations – for example, sweeping a point to create a line, sweeping a line to create 
a surface, and then copying or sweeping that surface to form additional surfaces or 
volumes. This method helps maintain geometric precision, reduces the likelihood of 
tolerance-related errors, and minimises the creation of coincident or non-merging 
features. 

Note: Combined lines cannot be deleted directly if they are already part of a surface definition 
– the associated surface must be deleted first. When redefining surfaces composed of more 
than four lines, any combined lines may also need to be removed, especially if the surface is 
to be replaced with two or more regular surfaces defined by only 3 or 4 lines. For more 
details, refer to: 

Help menu > Help Topics > Contents > Modeller Reference Manual > Chapter 4 – Model 
Geometry > Combined Lines 

Using scripting in LUSAS is highly effective for automating repetitive modelling tasks. A 
collection of example scripts is available for download from our User Area: 

http://www.lusas.com/protected/download/scripts.html 

For instance, the script "Create Multiple Surfaces from a Large Selection of Lines" 
automates the process of redefining multiple surfaces efficiently. Other useful scripts include 
"Check and Detect Short Lines" and "Select Nearby Features", both of which can assist 
with identifying and resolving connectivity issues. 

3. Discussion 

Connectivity problems are a common source of modelling errors in finite element analysis 
(FEA). These issues can lead to unintended structural behaviour, and often result in warnings 
or errors during the solution process, particularly related to the condition of the stiffness 
matrix. 

As one might expect, investing time upfront to create accurate and well-structured geometry 
is far more efficient than making extensive edits later in the modelling process. However, it is 
still essential to check all models to ensure that no connectivity issues are present. Section 
2.1 introduces tools and techniques for identifying such issues, while Section 2.2 outlines 
methods for resolving them. 

If you have any doubts or require specific advice for your type of analysis, please contact the 
LUSAS Technical Support team at support@lusas.com. 
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